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What is R?

R Is a freely distributed and widely
used programing language and
environment for statistical computing,
data analysis and graphics.
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What is R?

R Is a freely distributed and widely
used programing language and
environment for statistical computing,
data analysis and graphics.

R provides an unparalleled interactive
environment for data analysis.

t Is script-based (/.e. driven by
computer code) and not GUI-based
(point and click with menus).



}zico:~> R

R version 4.1.2 (2021-11-01) -- "Bird Hippie"
Copyright (C) 2021 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl?.0 (64-bit)

R is free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type '"license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R 1s a collaborative project with many contributors.
Type 'contributors()' for more information and
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.
Type "q()' to quit R.
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Getting Started

* Open RStudio as you would any program.
it's iIcon looks like this:




RStudio is an |IDE for R!

©Q - Or - Go to file/function «~ Addins ~ R class04 ~

Console Terminal Jobs Environment History Connections Tutorial

4
)

~/Desktop/courses/bimm143_S20/class04/ Import Dataset ~ List ~

Global Environment ~

R version 3.6.0 (2019-04-26) -- "Planting of a Tree"
Copyright (C) 2019 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl5.6.0 (64-bit) Environment is empty

R 1s free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute 1t under certain conditions.
Type '"license()' or 'licence()' for distribution details. RStUdIO app

Files Plots Packages Help Viewer

2 | New Folder € Delete «|Rename {3 More ~

Natural language support but running in an English locale

ne - Desktop = courses = bimm143_S20 = class04 R
A Name Size

R 1s a collaborative project with many contributors. )
Type 'contributors()' for more information and & class04.Rproj 505 B
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-1line help, or
"help.start()' for an HTML browser interface to help.
Type "q()' to quit R.




R.app GUI is NOT what we want!

@ R File Edit Format Workspace Packages & Data Misc Window Help

R Console

N oG ~ [ . @-
<D il — =

Q

R version 3.6.0 (2019-04-26) -- "Planting of a Tree"
Copyright (C) 2019 The R Foundation for Statistical Computing -
Platform: x86_64-apple-darwinl5.6.0 (64-bit) S

R 1s free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute 1t under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale

R 1s a collaborative project with many contributors.
Type 'contributors()' for more information and
"citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-line help, or
"help.start()' for an HTML browser interface to help.

Type 'g()' to quit R.

[R.app GUI 1.70 (7657) x86_64-apple-darwinl5.6.0]



R.app GUI is NOT what we want!

@ R File Edit Format Workspace Packages & Data Misc Window Help

R Console

<R il

R version 3.6.0 - "p a Tree"

Copyright (C) 201€ datig 1stical Computing iy
SSP 2019 @ UCSD P
Platfor‘m : XS6—64_ap ‘ ) ] TPS_2019_LPSOE ' . :

R 1s free software anc JTELY NO WARRANTY.
You are welcome to redis er certain conditions.
Type 'license()' or 'lice I1stribution details.

Natural language supgp Ln an English locale

R 1s a collaborative tributors.
Type 'contributors 8 1 and
"citation()' on R or in publications.

Type 'demo()' A os, 'help ine help, or
"help.start( L browser 1in% elp.
Type "q()’

[R.app GUI 1.70 (7657) x86_64-apple-darwinl5.6.0]



R.app GUI is NOT what we want!

@ R File Edit Format Workspace Packages & Data Misc Window Help

R Console

<R il

R version 3.6.0 -- "P a Tree"
Copyright (C) 201€ datig 1stical Computing -
Platform: x86_64-app ) R

R 1s free software anc JTELY NO WARRANTY.

You are welcome to redisS er certdain conditions. RStudio.app
Type 'license()' or 'lice I1stribution details.

Natural language supgp Ln an English locale

R 1s a collaborative tributors.
Type 'contributors 8 1 and
"citation()' on R or in publications.

Type 'demo()' A os, 'help ine help, or
"help.start( L browser 1in% elp.
Type "q()’

[R.app GUI 1.70 (7657) x86_64-apple-darwinl5.6.0]



RGui Is what we want!

-
ll"’:

RGui - [R Console]
F|Ie Edit View Misc NEEREGREEN Windows Help

Iﬁl B[

Set CRAN mirror...
Select repositories. ..

R version 2.12.1 Install package(s)...

Copyright (C) 2010 yUpdate packages... tical Computing

ISEN 3-900051-07-(
Platform: 1386-pC-

Install package(s) from local zip files. ..

R 18 free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute 1t under certaln conditions.
Type 'license()' or 'licence()' for distribution detalls.

R 18 a collaborative project with many contributors.
Type 'contributors()' for more information and

'citation()' on how to cite R or R packages 1n publications.
Type 'demo()' for sowe demos, 'help()' for on-line help, or

'help.start()' for an HTHL browser interface to help.
Type 'gi()' to gquit R.

[Previously saved workspace restored]




NOT what we want!

RGuUI IS

.
= RGui - [R Console] -
R File Edit View Misc BEEREGEEN Windows Help X

BB,

R wversion 2.12.1 Ir.
Copyright (C) 201( ypg
ISEN 3-900051-07-(
Platform: 1i386-pc- Install £

R 13 free software and comesd
You are welcome to redistribhid
Type 'license()' or 'licencel)

R 13 a collaborative project wit
Type 'contributors()' for more 1
'citation()' on how to cite R O ications.

Type 'demo()' for sowe demos, p, Or
'help.start()' for an HTHL L
Type 'gi()' to gquit R.

[Previously saved worksyg




We want RStudio a
separate IDE for R!

©Q - Or - Go to file/function «~ Addins ~ R class04 ~

Console Terminal Jobs Environment History Connections Tutorial

~/Desktop/courses/bimm143_S20/class04/ Import Dataset ~ y List ~

Global Environment ~

R version 3.6.0 (2019-04-26) -- "Planting of a Tree"
Copyright (C) 2019 The R Foundation for Statistical Computing
Platform: x86_64-apple-darwinl5.6.0 (64-bit) Environment is empty

R 1s free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute 1t under certain conditions.
Type '"license()' or 'licence()' for distribution details. RStUdIO app

Files Plots Packages Help Viewer

Natural language support but running in an English locale ML= S NESTEE L DA I R =

ne - Desktop = courses = bimm143_S20 = class04 R

A Name Size

R 1s a collaborative project with many contributors. )
Type 'contributors()' for more information and & class04.Rproj 505 B
'citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-1line help, or
"help.start()' for an HTML browser interface to help.
Tvpe 'g()' to quit R.




Tools > Global Options

 We will NOT save our workspace...

Options

Default working directory (when not in a project):

General
Browse...

Code

v Re-use idle sessions for project links
-' Appearance v Restore most recently opened project at startup

v Restore previously open source documents at startup
Pane Layout

Restore .RData into workspace at startup

Packages Save workspace to .RData on exit:

R Markdown v Always save history (even when not saving .RData)

P Remove duplicate entries in history
@&/~ Sweave

Show .Last.value in environment listin
4% Spelling g
v/ Use debug error handler only when my code contains errors

N .
3 Git/SVN Automatically expand tracebacks in error inspector

r . .
&= Publishing Wrap around when navigating to previous/next tab

- Terminal v| Automatically notify me of updates to RStudio




Tools > Global Options

* [Optional] Change to dark Appearance and
INncrease font size, etc. ..

Options

RStudio theme:
General Modern

plot <- function (x, y, ...

Code Zoom: {

SRS 125% v if (is.function(x) &&

= Appeargnce_ | Editor font: is.nullCattr(x, "clas:
| | Monaco v {

Editor font size: if (miSSing(y))
Packages 13 5 y <- NULL

Pane Layout

Editor theme:
Ambiance

Chaos hasylab <- function(...

@~ Sweave Chrome ' .
Clouds fall(is.na(

.. Clouds.Midnight | pmatch(names(list(.
Cobalt | "y]_ab")))

- [ 'Crimson Editor
¥ Git/SVN Dawn

o - Dracula if Chasylab(...))
8, Publishing Dreamweaver plot.function(x, v

Eclipse

. . Idle Fingers
Terminal Katzenmilch else

Kr Theme .
Material plOt . 'FunCt'LOI‘I(

Merbivore X : y .
Add... ylab = paste(
deparse(substitute

")),

R Markdown

*%  Spelling




Studid

© -+ OR > — Go to file/function ~ Addins ~ R| Project: (None) ~

Source Environment History Connections Tutorial

4
. i #* Import Dataset ~ ¥
Console Terminal P

Global Environment ~

o

R version 3.6.0 (2019-04-26) -- "Planting of a Tree" _ _
Copyright (C) 2019 The R Foundation for Statistical Computing Environment is empty
Platform: x86_64-apple-darwinl5.6.0 (64-bit)

R 1s free software and comes with ABSOLUTELY NO WARRANTY.
You are welcome to redistribute it under certain conditions.
Type 'license()' or 'licence()' for distribution details.

Natural language support but running in an English locale Plots Packages Help Viewer
/Y Zoom | - Export v~ | N
R 1s a collaborative project with many contributors.
Type 'contributors()' for more information and
"citation()' on how to cite R or R packages in publications.

Type 'demo()' for some demos, 'help()' for on-1line help, or class
"help.start()' for an HTML browser interface to help. 2seater
Type ‘q()' to QUit R. . compact

midsize

> Llibrary(ggplot?2) : ol ' ® minivan

> ggplot(mpg, aes(displ, hwy, color=class)) + . CTT ' pickup

+ geom_poi nt() . » 1 subcompact
>

| - Suv




Hands-on Topics (R Basics):

Vectors and vectorization
BEIERICINES
Calling Functions
Getting help in R
Workspace and RStudio projects



Hands-on Topics (R Basics):

Vectors and vectorization
Data frames
Calling Functions
Getting help in R
Workspace and RStudio projects




R has many data
Structures

These include:
* Veclor

e data frame
e |ist

e matrix

o arrays




R has many data
~ Structures
1D all elements of ..

the same "type" ..

.l These Include:
=\ ® vector

/ ® data frame
A— 7 7 o |
2D column - -' “St :
elements can be | ’ e matrix
different "types" - 2 o arr ayS

[ [




RStudio >

Set appearance and demo vectors and data.frames



Tips for learning

* Ask yourself qguestions.
* Work with frustration.

* Practice!
= And practice consciously:

= Make a prediction, then test it, then reflect...
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& bioboot.github.io C

a Schedule - BIMM 143

Videos:

e 4.1 Why R and RStudio [Z,
e 4.2 Major R data structures, data types, and using functions (=,

e 4.3 Working with DataCamp =/ N.B. Use your UCSD email invite to sign up and

visit our class group/organization.

Supporting Material:

UCSanDiego

BIMM 143 e Cheat Sheet: Base R overview |7,

e [ab: Hands-on section [,
A hands-on introduction to : : : :
e Lab: Video walk-through =/ focusing on introducing R data structures and core

the computer-based analysis
syntax,

of genomic and biomolecular
e Extra credit lab: Introduction to data in R 1=,
data from the School of

e Optional extension: Advanced conservation analysis of globins with R =/ this

Biological Sciences, UCSD (=,

demonstrates where we are going on our R learning journey. You should be able

Overview to do analysis like this on your own at the end of the course.
Schedule e Student Hours: After class on Thur @ 12:10pm =,
Computer Setup e Feedback: Muddy point assessment [,
Learning Goals Homework:
Assignments & Grading e Answerthe 04_HW_quiz questions on GradeScope 7,
Ethics Code e Submit your rendered 04_Lab_report (i.e.a PDF report generated from R) to
GradeScope [,
ﬁ > M e DataCamp: Sign-up to our 25_bioinformatic group/organization via the link in

your UCSD email and complete Introduction to R! =/ (4hrs).
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@ Home

UCSanDiego

BIMM 143

A hands-on introduction to

the computer-based analysis

of genomic and biomolecular
data from the School of
Biological Sciences, UCSD (.

Overview

Schedule

Computer Setup
Learning Goals
Assignments & Grading

Ethics Code

%« § o B

0

B4 Gmail

& bioboot.github.io C

G GDrive [31] Geal  [8] Blink .GitHub @ BiMM143 (@ BGGN213 @ BIMM194 @ BGGN239 (3 +v

G Schedule - BIMM 143

Videos:

e 4.1 Why R and RStudio [Z,
e 4.2 Major R data structures, data types, and using functions (=,

e 4.3 Working with DataCamp =/ N.B. Use your UCSD email invite to sign up and

visit our class group/organization.
Supporting Material:

e Lecture Slides: Large PDF [, Small PDF 1=,

e Cheat Sheet: Base R overview =,

e Lab: Hands-on section =,

e Lab: Video walk-through =/ focusing on introducing R data structures and core

syntax,

e Extra credit lab: Introduction to data in R 1=,

Optional extension: Advanced conservation analysis of globins with R =/ this

demonstrates where we are going on our R learning journey. You should be able
to do analysis like this on your own at the end of the course.

Student Hours: After class on Thur @ 12:10pm =,

Feedback: Muddy point assessment [,
Homework:

e Answer the 04_HW _quiz questions on GradeScope [,

e Submit your rendered 04_Lab_report (i.e. a PDF report generated from R) to

GradeScope [,

e DataCamp: Sign-up to our 25_bioinformatic group/organization via the link in
your UCSD email and complete Introduction to R! =/ (4hrs).
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& bioboot.github.io C

G Schedule - BIMM 143

Videos:

e 4.1 Why R and RStudio [Z,
e 4.2 Major R data structures, data types, and using functions (=,

e 4.3 Working with DataCamp =/ N.B. Use your UCSD email invite to sign up and

visit our class group/organization.

Supporting Material:

UCSanDiego

BIMM 143 e Cheat Sheet: Base R overview 7,
A hands-on introduction to

e Lab: Video walk-through =/ focusing on introducing R data structures and core

the computer-based analysis

syntax,

Ofgenom|cand b|om0|ecu|ar JUSEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE NN NN NN NN NN NN NN NN NN NN NN NN N EEEEEEEEEEEEEEEEESR
e Extra credit lab: Introduction to data in R 1=,

data from the School of

Biological Sciences, UCSD [, e Optional extension: Advanced conservation analysis of globins with R = this

demonstrates where we are going on our R learning journey. You should be able

Overview to do analysis like this on your own at the end of the course.

Schedule e Student Hours: After class on Thur @ 12:10pm [,

Computer Setup e Feedback: Muddy point assessment (2,

Learning Goals Homework:

Assignments & Grading e Answerthe 04_HW_quiz questions on GradeScope 7,

Ethics Code e Submit your rendered 04_Lab_report (i.e.a PDF report generated from R) to
GradeScope [,

ﬁ ! > a e DataCamp: Sign-up to our 25_bioinformatic group/organization via the link in
your UCSD email and complete Introduction to R! =/ (4hrs).
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R Language Basics

(Part 1)

Barry Grant
UC San Diego

Like a presentation
Push the Down arrow to advance
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https://bioboot.github.io/bggn213_F24/class-material/r_intro/r_intro.html

< m 7] @ bioboot.github.io/bggn213_F24/class-material/r_intro/r_intro.html#/checki:

@© Home B Gmail G Geal () GitHub @ BIMM143 @B BGGN213 @ BGGN239 & GDrive S Atmosphere @ BIMM194 Blink [ Newsv (5 +v

G Schedule - BGGN 213 B R Language Basics

Checking your understanding

We will use these types of “code chunks” to ask you to complete

some missing code, typically indicated by the blank place
holder.

For example, complete the code below so your answer sums to 10:

Exercise fill in the blank [OStartOver OShowHint]
S + 3 +

http://thegrantlab.org/teaching/

®© M + B




Hanas-on |opics:

Vectors and vectorization
BEIERIEIER
Calling Functions
Getting help in R
Workspace and RStudio projects



RStudio >

Demo with log() and plot() functions



Hanas-on |opics:

Vectors and vectorization
BEICRIEINER
Calling Functions
Getting help in R
Workspace and RStudio projects



RStudio Projects

* We will use a new RStudio project for each new class going forward.

File > New Project > New Directory > New Project...

New Project

Create New Project

Create project from:

Directory name:
lecture4|

{ New Directory
L Start a project in a brand new working directory

-L\ Create project as subdirectory of:
~/Desktop/courses/bggn213_S18

Existing Directory

s |3 Version Control
Checkout a project from a version control repository

* Projects will help keep us organized:

- Store our work Into separate directories (folders) with their own
workspace, history, and source documents.


https://docs.google.com/forms/d/1rY_8FywA2uoKBHz3k2XVdpbubWCBuH6x0Za6IGm0jsY/edit#responses

RStudio >

Create a BIMM143 working folder and create a class04 New Project

(create and save a simple Rscript...)

Terminal

quarto install tinytex




Homework: DataCamp Courses!

Complete the Introduction to R course on DataCamp
(Check Piazza for your DataCamp invite and sign up with your
UCSD email (i.e. first part of your email address) please.

Let me know NOW if you don’t have access to DataCamp!




DataCamp

campus.datacamp.com/courses/free-introduction-to-r/chapter-1-intro-to-basics-1?ex=1

Schedule - BIMM 143 How it works | R

DataCamp Course Outline

@ Exercise script.R

# Calculate 3 + 4

How it works 3+ 4

In the editor on the right you should type R code to solve the exercises. # Calculate 6 + 12

When you hit the 'Submit Answer' button, every line of code is
interpreted and executed by R and you get a message whether or not your
code was correct. The output of your R code is shown in the console in the

T
2
3
4
5

lower right corner.

R makesuse of the # signtoadd comments, sothatyouand others can
understand what the R code is about. Just like Twitter! Comments are not
run as R code, so they will not influence your result. For example, Calculate

3+ 4 in the editor on the right is a comment.

You can also execute R commands straight in the console. This is a good
way to experiment with R code, as your submission is not checked for Run Code

correctness.

R Console

® Instructions

In the editor on the right there is already some sample code. Can you see

which lines are actual R code and which are comments?

Add a line of code that calculates the sum of 6 and 12, and hit the

'Submit Answer' button.

Take Hint (-30 XP)




DataCamp

campus.datacamp.com/courses/visualization-best-practices-in-r/comparing-distributi

Schedule - BIMM 143 A simple boxplot | R
DataCamp Course Outline

@ Exercise script.R Se- Plots "

1 md_speeding %>% My fun subtitle

A simple boxplot 2 filter(vehicle_color == 'BLUE') %
>%
Let's get started by simply making a box plot similar to the ones we made # Map x and y to gender and speed
in the slides. columns respectively
ggplot(aes(x=gender, y=speed)) +
Modify the filter() tolookat 'RED' carsinstead of blue andthen # add a boxplot geometry

map the x-axisto gender andthey-axistodriver speed .Add your geom_boxplot() +

boxplot geometry and give it a title. # give plot supplied title
labs(title = 'My fun subtitle')

®@ Instructions

Modify filter() commandtofilterto 'RED' vehicles.

gender

Fillin aes() bymapping x to gender and y to speed .

Run Code 1/1

Add a boxplot geometry to the plot.

[ RC |
Title plot 'Speed of red cars by gender of driver' onsole

> md_speeding %>%
filter(vehicle_color == 'BLUE') %>%
# Map x and y to gender and speed columns respectively
ggplot(aes(x=gender, y=speed)) +
# add a boxplot geometry
geom_boxplot() +
# give plot supplied title
labs(title = 'My fun subtitle')

Take Hint (-30 XP)
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